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The Home Page and its Buttons

The JAAOS on CD-ROM’s “Home Page” document contains

JAA 0S8 on CD-ROM
three buttonSZ Table Of ContentS, SearCh, and Help lourml af the American Acackemy o FOrtho pasdic Surgeans
Table of Contents button: If you want to browse through .
the contents of this CD, click the Table of Contents button. The ‘ﬂ"' @
Table of Contents is a document that lists all the titles of the TR TR, EomEe
JAAOS articles on this CD (1993 to 1998) within the left-most e
Bookmarks portion of the document’s window. Articles are - A

From Fiiorsr Pl s Horer Prors s il Co

listed chronologically by Volume (year) and Number (issue
within the year). Clicking on the title of an article opens that
article in the main Acrobat Reader window.

Search button: If you want to locate a particular article The Home Page and its three buttons (circled)
(or group of articles) based on its contents, click on the Search
button. Clicking the Search button opens up the Search Query dialog box. You can type in
keywords or phrases in the Search Query window to locate just those articles containing your
keywords or phrases. Click an article’s name in the Search Results dialog box to open that article in
the window. More detailed information on the Search command is presented further on in this
document. Click the “Search Tips” link at the top of this page to go directly there.

Help button: If you need help using JAAOS on CD-ROM, click the Help button. That brings you
to the section that you are reading now. The Help pages contain information on navigating JAAOS
on CD-ROM, using Acrobat Reader, running Searches, and Search Troubleshooting.
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Using the JAAOS Navigation Bookmarks

Search Tips

Regardless of which JAAOS article you’re reading, you
can easily return to the Home Page (the one that contains
the large buttons for Table of Contents, Search, and Help).
At the bottom of each article’s list of article Bookmarks is a
special Bookmark folder named “JAAOS Home Page.” Click
on that Bookmark folder name to open the Home Page.

If you prefer, you can bypass the Home Page and go
directly to the Table of Contents, Search window, or Help
section directly from any article. To do this, click on the
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triangle to the left of the “JAAOS Home Page” bookmark so
that it points downward (if it isn’t already). Bookmarks for
each of the Home Page’s buttons appear immediately
below. Clicking on any of these navigation bookmarks

opens the appropriate file or dialog box. e |

Or, click on the

At the bottom of each article’s list of bookmarks
you’ll find special navigation bookmarks.

[} Diagnosis
In any article, click D Trestment
on the “JAAOS D Summary
Home Page” D) References
bookmark to open | [»
the Home Page.
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Viewing and Moving through the Articles
Since the JAAOS article pages are approximately letter-size—the same size as in the print version
of the journal—you probably won’t be able to fit a full article page at the default 100% scale within
your Acrobat Reader window (unless you have a fairly large monitor).
Using the Hand Tool (just press and drag on the page), you can quickly {""?
“slide” the page around the screen to bring off-screen text into view. Since
you can drag in any direction, the Hand Tool makes it easy to continue reading

Hand Tool (default)

from the bottom of one column to the top of the next. It’s particularly useful for &l

reading text that’s been magnified. (Note that dragging with the Hand Tool

won’t produce any effect if the entire page is already visible within the window:.) Zoom Tool
To change the magnification, click on the page with the Zoom Tool, use the =

View menu, or click on one of the Page View pre-sets in the Toolbar. D "

Moving within and between articles: Use the scroll bars or click the Previous/ | Page View Pre-sets
Next Page Toolbar icons to “page” through a single article. Click on article
bookmarks to quickly jump to a particular section (e.g., Methodology). 4 || b

When you’re done reading an article, you can continue browsing or searching  previous/Next Page
for more by clicking one of the navigation bookmarks (Home Page, Table of
Contents, etc.) at the bottom of every article’s list of bookmarks. If you’ve closed 44 || 13
all open articles, use the Previous/Next View icons to retrace your “view path”
through the CD within and across individual articles. Or, click on the “Open
CD-ROM Home Page” button on the Welcome page, which remains open in the
background until you click its Exit button. more help

Previous/Next View

Click Here to jump to the Help page that explains what all the Reader Toolbar icons are for.
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Adobe Acrobat Reader

The collection of JAAOS articles contained on this CD-ROM, including this document, are all in
Adobe Acrobat’s “Portable Document Format” (PDF). This means the articles can be accessed from
any computer, any platform, via the freely-distributed Adobe Acrobat Reader program—the
program you are now running.

The Reader program allows you to view each Journal article as it appeared originally in the
printed JAAOS, including all typefaces, layout, and graphics. You can search through them for
specific keywords, article titles, or authors, and print the articles as well.

For a detailed description of Reader’s many features, you should refer to the online help files that
are a part of the program, and so are available at any time.

To open Adobe’s Acrobat Reader online help documents:

Windows users: Select Help from the menu bar

Macintosh users: Press and hold on the Question Mark icon in the menu bar
(System 7) or click on Help in the menu bar (System 8)

For both platforms, drag down and select Acrobat Reader with Search Help.

Note: If you have trouble accessing the online help files from your Help menu, you can open either
help file (Reader.pdf and Search.pdf) directly from your hard drive. The two help files are located
in the Help folder within the Adobe Acrobat Reader application folder.

A guide to The Reader Toolbar appears on the next page. continues
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Adobe Acrobat Reader Toolbar

View page only (no bookmarks or
thumbnails)

View the bookmark links for the
current document

View the document’s thumbnails

Hand Tool (default): Press and drag the
screen image in any direction to reveal
off-screen text and graphics

Zoom Tools: Click with this tool on the
page to double the viewing
magnification. Hold down the Option
key (Mac) or Alt key (Windows) and
click on the page to halve the
magnification.

Select Tool: Press and drag to select
text, hold down the Option/Alt key to
select single columns

4

44

id

Jump to the first page or last page of
the current document

Go back one page, go forward
one page in the current document

Retrace your steps through a
document(s), moving to each view in
the order visited since starting Reader

J

Pre-set View Scales: Scale page to

B B (&

100%, Fit page in window, Fit
page width in window

Find (current document only) keywords or
phrases

Search (all JAAOS on CD-ROM
documents) for keywords or phrases

Re-display the Search Results window from
the most recent multi-file Search

E]

E

: Open Home Page

Highlight the previous/next page’s

matches from a Search
more help
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The Search feature allows you to
locate a specific document or
group of documents on this CD
based on specific keywords or
phrases contained in the

i@ i Adobe Acrobat Search :
Find Results Containing Text

document(s). E.%ﬂ:‘}:rmr; e T Wi
g 0 emming esauns atc ase
You can open the Search dialog } £ Sounds Like . [OJPraimity

box from Acrobat Reader’s Toolbar P e :
or Tools menu. You can also open | Searching in the JAAOS index.

the Search dialog by clicking the
Search button on the Home Page or
clicking the Search bookmark at the bottom of every article’s list of bookmarks.

Note that the Search command is different from the Find command, which is also available from
the Tools menu and the Toolbar. When you choose Find, only the currently open document is
searched. When you choose Search, all the articles on JAAOS on CD-ROM are searched for your
keywords or phrases. This Help section deals specifically with Searching, though some of the
information is applicable to the Find function as well.

Adobe Acrobat’s Search dialog box

Single Term Searching

To find occurrences of a single term, enter the term in the “Find Results Containing Text” box and
click Search. A search term can be a word, a word with wildcard characters, or any combination of
letters, numbers, and symbols. The wildcard characters are the asterisk (*), which matches zero,
one, or more characters; and the question mark (?), which matches any one character.

Open Home Page
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Phrase Searching
To search for a phrase, type the phrase in the “Find Results Containing Text” box and click Search.

Searching Options

“Match Case” limits the results of the search to find only those documents that contain words with
the same capitalization as the search term or terms you enter in the Find Results Containing Text
box. With Match Case selected, for example, searching for "He" finds all occurrences of "He," the
symbol for Helium, but not occurrences of "he," the common pronoun.

“Word Stemming” expands the search to find words that share word stems with the search
terms you enter in the Find Results Containing Text box. For example, with Word Stemming
selected, searching for "building” finds "build"” and "builds" as well as "building".

“Sounds Like” expands the search to find words that begin with the same letter as a search term
and that share some phonetic relation to a search term. For example, with Sounds Like selected,
searching for "Smith" also finds "Smyth" and "Smythe." Searching for Smith, however, also finds
"send" and "somewhat." Before searching with Sounds Like option, it is usually a good idea to use
the Word Assistant to see all the words that the Sounds Like option will find. To display the Word
Assistant dialog box, choose Search, then Word Assistant from the Tools menu.

“Thesaurus” expands the search to find words that bear some semantic resemblance to the search
terms you enter in the Find box. For example, with Thesaurus selected, searching for "begin" finds
"start," as well as "attack," "produce,” and many other terms.

The Thesaurus, Sounds Like, and Word Stemming options have no effect on phrase searches.

continues
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Fielded Searching

You can search for JAAOS articles
by Title or Author by opening up
the Search Preferences (File ->
Preferences -> Search) dialog and
turning on “Show Fields” in the
Search Query section. This adds
four blank fields to your Search
Query dialog: Title, Subject,
Author, and Keywords.

Note: Only the Title and Author
information have been entered for
the JAAOS articles.

To retrieve a particular article,
type the article title, or part of the
title, in the Title field and click
Search. To retrieve all the articles
by a particular author, type the

author’s name, or part of his/her name, in the Author field and click Search.

You can also use Author and/or Title field information to limit your keyword searches. For
example, if you want to search for all articles written by Dr. Jones that contain the word “patella,”
enter “Jones” in the Author field and “patella” in the Find Results Containing Text field, and click

Search.

Navigating the CD-ROM | Acrobat Reader ‘

Find Results Containing Text
I

With DocumentInfo ... :
Title :

Subject

Author
Keg,words|

OB ONS e
[JWord Stemming [ Thesaurus [JMatch Case

[]Sounds Like [ Proximity

| Searching in the JAAOS index.

Adobe Acrobat’s Search dialog box with “Show Fields” enabled

continues
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Advanced Searching

To use Acrobat Search with operands such as AND or OR, and for a detailed explanation of
searching with Boolean expressions, see the document called “Search.pdf” in the Help folder within
the Adobe Acrobat Reader application folder.

Viewing and Printing Search Results

When you enter a search query, the list of found documents is displayed in the Search Results
window. Every document returned from a search is assigned a Score indicating how likely it is that
the document contains the information for which you are searching. The score is represented by a
circle before each document. The more filled in the circle is, the more likely that document contains
relevant information.

To open a document, click on its name in the Search Results window and click View, or just
double click the document's name. The Search Results window will close. To bring the Search
Results box back into view (so you can go to another matching article), click on the Search Results
icon in the Toolbar. To execute another search from scratch, click on the Search icon.

Copying and Printing the Search Results List
Enlarge the Search Results window so all the articles are showing, then...

Windows

1. Press PRINT SCREEN. A bitmap of the desktop screen is placed onto the Clipboard. (Note: if
pressing PRINT SCREEN does not copy the screen onto the Clipboard, you may not have an
enhanced keyboard. Try pressing ALT+PRINT SCREEN or SHIFT + PRINT SCREEN to copy the

continues

screen.)
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2. To view the bitmap search screen, open your Windows word processing package (WordPerfect,
Word, etc.) place the insertion point where you want to paste the bitmap search screen and
choose the paste feature.

3. The bitmap of the search screen will be pasted on the new page and should then be printed as a
normal word processing file.

4. If a word processing application is not available, Windows has a Clipboard Viewer that will
allow you to view and save the bitmap search screen to be printed as needed. See your Windows
User Guide, Application Basics for more help.

Macintosh

1. Press PRINT SCREEN (F13 or Command-Shift-3). A bitmap of the desktop screen image is
created and placed on your hard drive as “Picture 1.” (System 8 users can press Command-Shift-
4 to capture just a portion of the screen.)

2. To view the bitmap image of the search screen, double-click on the Picture 1 file. It will open in
Simple Text. You can save this document and print it.

more help
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Acrobat Search Error Messages/Troubleshooting:

Acrobat Search could not initialize its search engine.
This indicates there has been a problem with the Acrobat installation. Reinstall the Reader with
Search program.

Acrobat Search is missing one or more needed components.
This indicates there has been a problem with the Acrobat installation. Reinstall the Reader with
Search program.

Acrobat Search is not able to understand your query. A null quoted

word or phrase was encountered.
You entered two quotation marks (") next to one another. Only use quotation marks to enclose
a phrase that contains search operators.

Acrobat Search is not able to understand your query. Memory is running low.
You do not have enough memory for Acrobat Search to find the documents that meet your
search criteria. If you are running more than one program, quit all programs except Acrobat
Reader with Search and try the query again. You might also increase the memory in your
computer. If you are using a Macintosh, you might also want to increase the amount of
memory used by Acrobat Reader with Search. See Increasing the amount of memory available
to the Macintosh version of the Reader with Search program in the on-line help for details.

continues
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Acrobat Search is not able to understand your query.

The "operator name" is missing an operand.
An Acrobat Search operand, such as AND or OR, is not used correctly. For a detailed
explanation of searching with Boolean expressions, see the document called “Search.pdf” in the
Help folder within the Adobe Acrobat Reader application folder.

The opening screen display is not of good quality.
Make sure your monitor is set to run at 256 or millions of colors. You can change the settings in
Windows 95 by accessing the control panel. In Windows 3.x choose the Main Program Group
and then Windows Settings. In the MacOS go to the Monitors control panel to change the
setting. m
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